
  565

CHAPTER 15

Formatting and calculating 
date and time

You Can use date and time values to stamp documents and to perform date and time 
arithmetic. Creating a production schedule or a monthly billing system is relatively 
easy with Microsoft Excel. Although Excel uses numeric values to count each nano-

second, starting from the beginning of the twentieth century, you can use formatting to 
display those numbers in whatever form you want.

Understanding how Excel records dates and times
Excel assigns serial values to days, hours, minutes, and seconds, which makes it possible for 
you to perform sophisticated date and time arithmetic. The basic unit of time in Excel is 
the day. Each day is represented by a serial date value. The base date, represented by the 
serial value 1, is Sunday, January 1, 1900. When you enter a date in your worksheet, Excel 
records the date as a serial value that represents the number of days between the base date 
and the specified date. For example, Excel represents the date January 1, 2014, by the serial 
value 41640, representing the number of days between the base date—January 1, 1900—
and January 1, 2014.

The time of day is a decimal value that represents the portion of a day that has passed since 
the day began—midnight—to the specified time. Therefore, Excel represents noon by the 
value 0.5 because the difference between midnight and noon is exactly half a day. Excel 
represents the time/date combination 12:59:54 PM, January 1, 2014, by the serial value 
41640.54159 because January 1, 2014, is day 41640 (counting January 1, 1900, as day 1), 
and the interval between midnight and 12:59:54 PM amounts to .54159 of a whole day.

Note
You can see the serial value of a formatted date by selecting the cell containing the 
date and pressing Ctrl+Shift+tilde (~) . Or click the Number Format drop-down list on 
the Home tab and select the General format . Either way, to return the cell to its date 
format, press Ctrl+Z .
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Using the 1904 date system
Whereas all PCs and some Macintoshes use 1900 as the base year for computing 
serial date values, the Macintosh used 1904 for much of its history . (The Macintosh 
debuted in 1984 with Apple’s legendary Orwellian TV ad that aired only once, during 
the Super Bowl .) Or maybe it was because 1900 was not a leap year . (It’s a long story 
about the programming of calendar systems and the calculation of leap years…Bing 
it .) If you transfer documents between Excel for the Macintosh and Excel for Windows, 
the proper date system for the worksheet is automatically set for you . When the date 
system changes, existing serial date values display different dates, but the underlying 
values do not change . But if you change date systems after you start entering dates in a 
worksheet, all your dates will be off by four years .

You can change the base date (the date that corresponds to the serial value 1) from 
January 1, 1900 to January 2, 1904 . Click the File tab, click Options, select the Advanced 
category, and then select the Use 1904 Date System check box in the When Calculating 
This Workbook area .

When you select this check box, the serial date values in your worksheet remain the 
same, but the display of all dates changes so that the serial values of any dates you 
enter on your Excel for Windows worksheets match corresponding serial values from 
Excel for the Macintosh worksheets . If you transfer information into Excel for Windows 
from a worksheet created in Excel for the Macintosh, selecting this option ensures 
that Excel evaluates the serial date values correctly . In this book, we use the 1900 date 
system .

Entering dates and times
Although Excel records dates and times as serial date values, you don’t have to type them 
that way. You can manipulate dates and times in your worksheet formulas just as you 
manipulate other types of values. You enter date values in formats that Excel automati-
cally applies. To enter date values in this way, type the date in one of the following formats: 
m/d/yy, d-mmm-yy, d-mmm, or mmm-yy. (You can also type four-digit years for any of 
these formats.)
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Note
You can change the default date, time, currency, and numbering settings through the 
Clock, Language, And Region item in Windows Control Panel (or Date, Time, Language, 
And Regional Options in Windows XP) . These settings determine how Excel interprets 
your date entries . For example, with regional options set to Italian, typing a date in 
d/m/yy format results in a properly displayed date, but if you type the same date with 
regional options set to English, the entry is interpreted as text .

If your entry doesn’t match any of the built-in date or time formats, Excel picks the format 
that’s most similar to your entry. For example, if you type 1 dec, you see the formatted 
entry 1-Dec in the cell. In the formula bar, the entry appears as 12/1/2013 (if the current 
year is 2013) so that you can edit the date more easily.

You can also type times in a time format. Select a cell, and type the time in one of the fol-
lowing forms: h:mm AM/PM, h:mm:ss AM/PM, h:mm, h:mm:ss, or the combined date and 
time format, m/d/yy h:mm. Notice that you must separate the hours, minutes, and seconds 
of the time entries by colons.

For more information about custom formats, see “Creating your own date and time formats” 
later in this chapter .

If you don’t include AM, PM, A, or P with the time, Excel uses the 24-hour (military) time 
convention. In other words, Excel always assumes that the entry 3:00 means 3:00 AM, unless 
you specifically enter PM.

You can enter the current date in a cell or formula by holding down Ctrl and pressing 
the semicolon (;) key. This enters the date stamp in the short-date format currently set in 
Control Panel. Enter the current time in a cell or formula by holding down Ctrl+Shift and 
pressing the colon (:) key. This enters the time stamp in h:mm AM/PM format. (Of course, 
the colon and semicolon occupy the same key—the Shift key changes the entry to a time 
stamp.)
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INSIDE OUT   The magic crossover date

December 31, 2029, is the default magic crossover date—that is, the last day Excel 
assumes is in the future if you enter the year using only two digits . For example, if you 
type 12/31/29 in a cell, Excel assumes you mean the year 2029 . If, however, you type 
1/1/30 in a cell, Excel interprets it to mean January 1, 1930 . (Perhaps this would be bet-
ter characterized as a crossunder date .)

You can change this magic date, but not from Excel; instead you use Windows Control 
Panel . (Therefore, changing this setting also affects any other applications that need to 
interpret past or future date entries .) In Windows, open Control Panel and click Clock, 
Language, And Region (or Regional And Language Options in Windows XP) . Next, click 
Region, and then click the Additional Settings button . (In Windows 7, click Region And 
Language, and then Additional Settings . In Windows Vista, click Regional And Lan-
guage Options, and then Customize This Format . In Windows XP, click the Customize 
button on the Regional Options tab .) Finally, click the Date tab, and change the last 
date (2029) to the value of your choice . Of course, you’re still limited to a 100-year 
span; if you change the last date that Windows recognizes as being in the future, the 
corresponding beginning date—January 1, 1900—changes accordingly . If you need to 
enter century-spanning dates, you should get into the habit of typing the full four-digit 
year to avoid surprises .

Entering a series of dates
You can create an evenly spaced series of dates in a row or column in several ways, but the 
job is especially easy when you use the fill handle. Suppose you want to create a series of 
dates in row 1. The series begins with March 1, 2011, and the dates must be exactly one 
month apart.

If you type 3/1/2014 in cell A1 and drag the fill handle to the right, Excel extends the series 
of dates incrementally by days, as shown in Figure 15-1. After you drag, Excel displays an 
option button adjacent to the selection. Click the button to display a menu, shown in Fig-
ure 15-1, that provides a number of AutoFill options; select Fill Months to convert the day 
series into a month series.

If you drag the fill handle by right-clicking it, a shortcut menu that is similar to the options 
menu appears. You can use this shortcut menu to select a fill command before performing 
any fill action. If what you want to do isn’t represented on the menu, click the Series com-
mand to display the Series dialog box.
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Figure 15-1 After you drag the fill handle to extend a date series, use the options menu to 
adjust the series.

You can use the Series command to tend to a series of dates with a bit more flexibility than 
with the fill handle. To use this approach, type the starting date, select the range of cells 
you want to fill (including the starting date), click the Fill button in the Editing group on the 
Home tab, and click Series to display the Series dialog box shown in Figure 15-2.

Figure 15-2 Use the Series dialog box to create date series.
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When extending a series of dates, remember the following:

 ● You can use the Series In options to choose whether to extend the selected date 
across the current row or down the current column.

 ● You can use the Step Value option to specify the interval between cells. For example, 
by typing 2 in the Step Value text box and selecting Month in the Date Unit area, you 
can create a series of dates occurring every other month. By typing a negative num-
ber in the Step Value text box, you can create a series that decreases (goes backward 
in time).

 ● You can use the Stop Value text box to set an ending date for the series. Using this 
method, you can use the Series command without having to figure out how many 
cells to select in advance. For example, to enter a series of dates that extends from 
3/1/2014 through 2/1/2015, type 3/1/2014 in a cell. Then select only that cell, dis-
play the Series dialog box, select the Columns option, and type 2/1/2015 in the Stop 
Value text box. Excel extends a series of dates following the original cell.

For more information about AutoFill and the Series command, see “Filling cells and creating 
data series” in Chapter 8, “Worksheet editing techniques .”

Extending an existing date series

The AutoFill feature uses the selected cells to determine the type of series you intend to 
create when you drag the fill handle. AutoFill copies text and nonsequential values and 
increments sequential numeric values. Because dates are stored as serial values, AutoFill 
extends them sequentially, as illustrated in Figure 15-3.

Figure 15-3 Starting with the values in the Selected Values area, we created the values to the 
right by dragging the fill handle.
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When you use the fill handle to extend the value in a single selected cell, Excel assumes 
you want to increment the numeric value in each cell. (If you want to copy the cell instead, 
hold down Ctrl while dragging the fill handle.) Notice in Figure 15-3 that the entries in 
rows 7 through 11 contain text values. AutoFill recognizes text entries for days and months 
and extends them as though they were numeric values. In addition, when a cell contains a 
mixed text and numeric entry (as in row 10), AutoFill copies the text portion if it’s not the 
name of a month or day and extends the numeric portion if it occurs at either end of the 
entry.

Formatting dates and times
After you type a date or time in a cell, you can use the Number Format drop-down list on 
the Home tab on the ribbon to change its format to one of the popular date and time for-
mats, or you can click More Number Formats at the bottom of the list to select any of the 
built-in formats. In the Format Cells dialog box, select the Date or Time category to display 
the list of available formats in the Type box on the right. A preview of the format appears in 
the Sample box in the upper-right corner, as shown in Figure 15-4.

Figure 15-4 Use the Number tab in the Format Cells dialog box to apply date and time formats 
to cells.
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Note
At the top of the list of date and time formats are several types that begin with an 
asterisk (*) . These formats respond to changes in the settings available on the Date and 
Time tabs in the Customize Regional Options dialog box, which you access by opening 
Windows Control Panel, clicking Regional And Language Options, and then clicking the 
Customize button on the Formats tab . All other formats are not affected by these Con-
trol Panel settings .

Most of the date and time formats are easy to understand, but a few special formats exist:

 ● The 13:30 and 13:30:55 time formats use the 24-hour (military) time convention.

 ● The 30:55.2 time format displays only minutes and seconds; Excel displays a fraction 
of a second as a decimal value.

 ● The 37:30:55 time format displays elapsed time.

Note
You can press Ctrl+1 to quickly display the Format Cells dialog box .

Creating your own date and time formats
To supplement the standard date and time formats, you can create custom formats by 
using the same technique you use to create custom numeric formats.

For more information about custom formats, see “Creating custom number formats” in Chap-
ter 9, “Worksheet formatting techniques .”

For example, you can create a format that displays all the available date and time informa-
tion. The entry 2/24/14 would appear as Tuesday, February 24, 2014 0:00:00.0. To create 
this format, follow these steps:

1. Select the cell that contains the date.

2. Press Ctrl+1 to display the Format Cells dialog box, and if necessary click the 
Number tab.

3. Select the Custom category.
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4. Highlight the entry in the text box at the top of the Type list, and type the following 
custom format code: dddd mmmm dd, yyyy h:mm:ss.0

5. Click OK. Excel stores the new format in the Type list for the Custom category and 
displays the date using the new format in the selected cell.

You can use the same procedure to display only a portion of the date or the time infor-
mation available. For example, if you create the format mmmm, Excel displays the date 
2/24/2014 as simply February.

Table 15-1 shows the formatting codes you can use to create custom date and time for-
mats. Be sure to keep two facts in mind. First, Excel assumes that m means months, but if 
you type the code m immediately after an h, or the code mm immediately after an hh, 
Excel displays minutes instead of months. Second, if you include one of the codes AM/PM, 
am/pm, A/P, or a/p in a time format, Excel uses the 12-hour time convention; if you omit 
these codes, Excel uses the 24-hour (military) time convention.

TABLE 15-1 Codes for creating custom date and time formats

Code Display

General Number in General (serial value) format.
d Day number without leading zero (1–31).
dd Day number with leading zero (01–31).
ddd Day-of-week abbreviation (Sun–Sat).
dddd Complete day-of-week name (Sunday–Saturday).
m Month number without leading zero (1–12).
mm Month number with leading zero (01–12).
mmm Month name abbreviation (Jan–Dec).
mmmm Complete month name (January–December).
yy Last two digits of year number (00–99).
yyyy Complete four-digit year number (1900–2078).
h Hour without leading zero (0–23).
hh Hour with leading zero (00–23).
m Minute without leading zero (0–59).
mm Minute with leading zero (00–59).
s Second without leading zero (0–59).
ss Second with leading zero (00–59).
s.0 Second and tenths of a second without leading zero.
s.00 Second without leading zero and hundredths of a second without leading 

zero.
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Code Display

ss.0 Second without leading zero and tenths of a second with leading zero.
ss.00 Second and hundredths of a second with leading zero.
AM/PM Time in AM/PM notation.
am/pm Time in am/pm notation.
A/P Time in A/P notation.
a/p Time in a/p notation.
[ ] Brackets display the absolute elapsed time when used to enclose a time code, 

as in [h]. You can use brackets only around the first component of the code.

After you add a custom date or time format to the Type list, you can apply it to any date 
or time entry. Select the Custom category, select the format you entered from the Type list 
(new custom formats appear at the bottom of the list), and click OK to apply the format.

Measuring elapsed time

You can enclose time codes in brackets, as listed at the bottom of Table 15-1, to display 
more than 24 hours, more than 60 minutes, or more than 60 seconds in a time value. The 
brackets must always appear around the first code in the format. Excel provides one built-in 
elapsed-time code, [h]:mm:ss, in the Custom category Type list. Other valid codes for mea-
suring elapsed time include [mm]:ss and [ss].

Bracketed codes have no effect if you use them in any position of the format other than 
first. For example, if you use the code h:[mm]:ss, Excel ignores the brackets and displays the 
time using the regular h:mm:ss format.

Note
One format in the Time category on the Number tab in the Format Cells dialog box 
represents elapsed time: 37:30:55 . This is the same as the [h]:mm:ss format in the Cus-
tom category .

Suppose you want to determine the elapsed time between two dates. Type the following 
values into cells A1 and A2, respectively:

11/23/14 13:32

11/25/14 23:59
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And type the following formula into cell A3:

=A2–A1

If you use the Custom category on the Number tab of the Format Cells dialog box (press 
Ctrl+1) to apply the built-in format [h]:mm:ss to cell A3, the result of the formula is 
58:27:00—the total elapsed time between the two dates, as shown in Figure 15-5. If you 
apply the standard h:mm:ss format to cell A3 instead, the result is 10:27:00—the difference 
between the two times of day. Without the elapsed-time-format code brackets [ ], Excel 
ignores the difference in dates.

Figure 15-5 The elapsed-time format is buried in the Custom category of the Number tab in the 
Format Cells dialog box.
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TROUBLESHOOTING
I can’t enter a number of hours greater than 9,999
Suppose you have a worksheet in which you keep a running total of flying time for 
pilots, using the time formats in Excel . Whenever you try to enter a number of hours 
greater than 9,999 (which isn’t uncommon), Excel treats the entry as text . What’s 
wrong?

Nothing is wrong—that’s just a built-in limitation of Excel . Here are a couple of ways to 
work with this limitation:

 ● Use an elapsed-time format . In the Cells group on the Home tab, click Format, 
click Format Cells, click the Number tab if necessary, select the Custom category, 
and then select [h]:mm:ss in the Type list to apply the built-in, elapsed-time 
format . If you don’t need to record seconds, you can delete :ss . Elapsed-time for-
mats can store and display an unlimited number of hours .

 ● If you need to enter more than 9,999 hours at a time, you have to break it into 
two smaller chunks and type it in two cells .

You should also know that when you type a time greater than 24 hours (even 24:01), 
Excel adds a date in the formula bar . Unless the number of hours typed exceeds a year’s 
worth, the date Excel adds is sometime in 1900; you just have to live with that . You 
can select the year in the formula bar and type the correct year, but then the year is 
displayed in the cell along with the time . Otherwise, the date doesn’t show in the cell 
unless you format it accordingly .

Calculating with date and time
Because Excel records dates as serial date values, you can use dates in formulas and func-
tions as you would any other value. Suppose you want to find the date that falls exactly 200 
days after July 4, 2014. If cell A1 contains the entry 7/4/14, you can type the following for-
mula to compute the date 200 days later: =A1+200, which results in 1/20/15 (or the serial 
date value 42024).

As another example, suppose you want to find the number of weeks between October 31, 
2003, and May 13, 2013. Type the formula =(("5/13/13")–("10/31/03"))/7, which returns 
497 weeks.

You can also use times in formulas and functions, but the results of time arithmetic are 
not as easy to understand as the results of date arithmetic. For example, you can deter-
mine how much time has elapsed between 8:22 AM and 10:45 PM by typing the formula 
="22:45"–"8:22". The result is .599306, which can be formatted using a 24-hour time 
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format (one that doesn’t include AM/PM) to display 14:23. Excel displays the result relative 
to midnight.

Suppose you want to determine the time that is 2 hours, 23 minutes, and 17 seconds after 
12:35:23 PM. The formula =("12:35:23 PM")+("2:23:17") returns the correct answer, .624074, 
which can be formatted as 14:58:40. In this formula, 2:23:17 represents not an absolute 
time (2:23:17 AM) but an interval of time (2 hours, 23 minutes, and 17 seconds). This format 
is perfectly acceptable to Excel.

TROUBLESHOOTING
Excel displays my time as #####
Usually, a cell full of number signs means the cell isn’t wide enough to show its dis-
played contents . But Excel can’t display negative numbers as dates or times . If the 
result of a date or time calculation is negative and you attempt to display this result 
in a date or time format, you will see a cell full of number signs, no matter how much 
you widen the cell . This typically happens when you subtract a later time of day from 
an earlier time of day . You can work around the problem by converting the result to 
elapsed hours . To do that, multiply the result by 24 and display it in a numeric format, 
not a date or time format .

Working with date and time functions
Using the Excel date and time functions, you can perform worksheet calculations quickly 
and accurately. For example, if you use your worksheet to calculate your company’s 
monthly payroll, you might use the HOUR function to determine the number of hours 
worked each day and the WEEKDAY function to determine whether employees should be 
paid at the standard rate (for Monday through Friday) or at the overtime rate (for Saturdays 
and Sundays).

In the following sections, we explore a few of the most useful date and time functions in 
detail. You can access all 20 of the date and time functions available in Excel by clicking the 
Date & Time button on the Formulas tab on the ribbon.

Using the TODAY and NOW functions

You can type =TODAY( ) in a cell or a formula to insert the serial value of the current 
date. If you type the function in a cell with the General format (which is the default), Excel 
displays the resulting value in mm/dd/yyyy format. Although this function takes no argu-
ments, you must remember to include the empty parentheses. (Remember that arguments 
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are variables that supply the values a function needs to perform its calculations. You place 
arguments between the parentheses for functions that require them.)

Similarly, you can type =NOW( ) in a cell or formula to insert the current date and time. 
This function also takes no arguments. The result of the function is a serial date and time 
value that includes an integer (the date) and a decimal value (the time). Excel doesn’t 
update the value of NOW continuously. If the value of a cell that contains the NOW func-
tion isn’t current, you can update the value by recalculating the worksheet. (You recalculate 
the worksheet by making a new entry or by pressing F9.) Excel also updates the NOW func-
tion whenever you open or print the worksheet.

The NOW function is an example of a volatile function—that is, a function whose calculated 
value is subject to change. Any time you open a worksheet that contains one or more NOW 
functions, Excel prompts you to save changes when you close the worksheet, regardless of 
whether you made any, because the current value of NOW has changed since the last time 
you used the worksheet. (Another example of a volatile function is RAND.)

For more about the RAND function, see “The RAND and RANDBETWEEN functions” in Chap-
ter 14, “Everyday functions .”

Using the WEEKDAY function

The WEEKDAY function returns the day of the week for a specific date and takes the argu-
ments (serial_number, return_type). The serial_number argument can be a serial date value, 
a reference to a cell that contains either a date function or a serial date value, or text such 
as 1/27/14 or January 27, 2014. If you use text, be sure to enclose the text in quotation 
marks. The function returns a number that represents the day of the week on which the 
specified date falls. The optional return_type argument determines the way the result is dis-
played. Table 15-2 lists the available return types.

TABLE 15-2 Return type codes

If return_type is WEEKDAY returns

1 or omitted A number from 1 through 7, where 1 is Sunday and 7 is Saturday 
2 A number from 1 through 7, where 1 is Monday and 7 is Sunday 
3 A number from 0 through 6, where 0 is Monday and 6 is Sunday

Note
You might want to format a cell containing the WEEKDAY function with a custom day-
of-the-week format, such as dddd . By applying this custom format, you can use the 
result of the WEEKDAY function in other functions and still have a meaningful display 
on the screen .
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Using the YEAR, MONTH, and DAY functions

The YEAR, MONTH, and DAY functions return the value of the year, month, and day por-
tions of a serial date value. All three take a single argument, which can be a serial date 
value, a reference to a cell that contains either a date function or a serial date value, or a 
text date enclosed in quotation marks. For example, if cell A1 contains the date 3/25/2014, 
the formula =YEAR(A1) returns the value 2014, the formula =MONTH(A1) returns the value 
3, and the formula =DAY(A1) returns the value 25.

Using the HOUR, MINUTE, and SECOND functions

Just as the YEAR, MONTH, and DAY functions extract the value of the year, month, and 
day portions of a serial date value, the HOUR, MINUTE, and SECOND functions extract the 
value of the hour, minute, and second portions of a serial time value. For example, if cell B1 
contains the time 12:15:35 PM, the formula =HOUR(B1) returns the value 12, the formula 
=MINUTE(B1) returns the value 15, and the formula =SECOND(B1) returns the value 35.

Using the DATEVALUE and TIMEVALUE functions

The DATEVALUE function translates a date into a serial value. You must type the single 
argument as text, using any date from 1/1/1900 to 12/31/9999, and you must add quo-
tation marks around the text. You can enter the argument using any of the built-in date 
formats; however, if you type the date without a year, Excel uses the current year from your 
computer’s internal clock. For example, the formula =DATEVALUE("December 31, 2014") 
returns the serial value 42004.

Similarly, the TIMEVALUE function translates a time into a decimal value. You must type its 
single argument as text. You can use any of the built-in time formats, but you must add 
quotation marks around the text. For example, the formula =TIMEVALUE("4:30 PM") returns 
the decimal value 0.6875.

Working with specialized date functions
Excel includes a set of specialized date functions that perform operations such as calcula-
tions for the maturity dates of securities, for payroll, and for work schedules.

Using the EDATE and EOMONTH functions

You can use the EDATE function to calculate the exact date that occurs an indicated number 
of months before or after a given date. It takes the arguments (start_date, months), where 
start_date is the date you want to use as a starting point and months is an integer value 
that indicates the number of months before or after the start date. If the months argument 
is positive, the function returns a date after the start date; if the months argument is nega-
tive, the function returns a date before the start date. For example, to find the date that 
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falls exactly 23 months after June 12, 2014, type the formula =EDATE("6/12/2014", 23), 
which returns the value 42502, or May 12, 2016.

The EOMONTH function returns a date that is an indicated number of months before or 
after a given date. Although EOMONTH is similar to EDATE and takes the same arguments, 
the value returned is always rounded up to the last day of the month. For example, to cal-
culate the serial date value that is the last day of the month 23 months after June 12, 2014, 
type the formula =EOMONTH("6/12/2014", 23), which returns 42521, or May 31, 2016.

Using the YEARFRAC function

The YEARFRAC function calculates a decimal number that represents the portion of a year 
that falls between two given dates. This function takes the arguments (start_date, end_date, 
basis), where start_date and end_date specify the period of time you want to convert to a 
fractional year. The basis argument is the type of day count you want to use, as described in 
Table 15-3.

For example, to determine what fraction of a year is represented from 4/12/10 to 12/15/10, 
you can type the formula =YEARFRAC("4/12/14", "12/15/14"). This formula returns 
0.675 based on the default 30-day month and 360-day year.

TABLE 15-3 Basis codes

If basis is YEARFRAC returns

0 (or omitted) 30/360, or 30 days per month and 360 days per year, as established in the 
United States by the National Association of Security Dealers (NASD)

1 Actual/actual, or the actual number of days in the month(s)/actual days in 
the year

2 Actual/360
3 Actual/365
4 European 30/360

Using the WORKDAY, NETWORKDAYS, WORKDAY .INTL, and 
NETWORKDAYS .INTL functions

The WORKDAY and NETWORKDAYS functions are invaluable for anyone who calculates 
payroll and benefits or determines work schedules. Both functions return values based on 
working days, excluding weekend days. In addition, you can choose whether to include 
holidays and specify the exact dates. The .INTL forms of these two functions include an 
additional argument you can use to specify exactly what constitutes a weekend.

The WORKDAY function returns the date that is an indicated number of working days 
before or after a given date. This function takes the arguments (start_date, days, holidays), 
where start_date is the date you want the function to count from and days is the number 
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of workdays before or after the start date, excluding weekends and holidays. Use a positive 
value for days to count forward from the start date; use a negative value to count back-
ward. The optional holidays argument can be an array or a reference to a cell range that 
contains any dates you want to exclude from the calculation. If you leave holidays blank, 
the function counts all weekdays from the start date. For example, to determine the date 
that is 100 working days, not counting holidays, from the current date, type the formula 
=WORKDAY(NOW( ),100).

Similarly, the NETWORKDAYS function calculates the number of working days between 
two given dates. It takes the arguments (start_date, end_date, holidays). For example, to 
determine the number of working days from January 15, 2014 to June 30, 2014, type the 
formula =NETWORKDAYS("1/15/14", "6/30/14"), which results in a value of 119.

The WORKDAY.INTL and NETWORKDAYS.INTL functions work the same way as their non-
INTL counterparts, but each includes an additional weekend argument. These functions use 
the form (start_date, days, weekend, holidays), where weekend is a number indicating which 
days you want to omit, as shown in Table 15-4.

TABLE 15-4 INTL weekend codes

If weekend is The weekend days omitted are

1 or omitted Saturday, Sunday 
2 Sunday, Monday 
3 Monday, Tuesday
4 Tuesday, Wednesday
5 Wednesday, Thursday
6 Thursday, Friday
7 Friday, Saturday
11 Sunday only
12 Monday only
13 Tuesday only
14 Wednesday only
15 Thursday only
16 Friday only
17 Saturday only

There are two ways to specify the weekend argument. The first is to enter one of the num-
bers shown in Table 15-4, which are codes that specify days you want to omit. The other 
method is to enter a 7-digit numeric text string with which you specify individual days of 
the week (starting with Monday) that you want to include and exclude; a zero (0) indicates 
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a workday, and a one (1) indicates a nonwork (weekend) day. For example, the string 
"0010100" specifies Wednesdays and Fridays as your "weekend" days.

For example, the formula =NETWORKDAYS.INTL("1/1/14","2/21/15","0010100") returns the 
value 297, the number of working days between January 1, 2014 and February 21, 2015, 
skipping all Wednesdays and Fridays.
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CHAPTER 16

Functions for financial analysis

With the financial functions provided with Microsoft Excel, you can perform com-
mon business calculations, such as net present value and future value, without 
building long and complex formulas. These functions are the heart of spread-

sheets—the word spreadsheet itself refers to the seemingly antiquated system of using 
special grid paper to track financial information. Functions have taken the place of the old 
10-key calculator sequences (algorithms) used by accounting professionals before comput-
ers revolutionized the discipline.

The financial functions built into Excel fall into three major categories: investments, depreci-
ation, and securities. The functions included within each category accept similar arguments. 
To streamline this chapter, we first define the common arguments and then discuss their 
implementation in the individual functions. Excel offers more than 50 financial functions, 
and in this chapter we touch on most of them, with special emphasis on those most often 
used, needed, or misunderstood. For complete information about all the built-in functions 
that Excel has to offer, you can use the onscreen tools covered in “Using the built-in func-
tion reference in Excel” in Chapter 13, “Using functions.”

Calculating investments
The functions we discuss in this section are used when working with cash flows. All of the 
functions for calculating investments are available on the Formulas tab, in the Function 
Library group’s Financial drop-down list.

Table 16-1 lists the arguments used in functions dedicated to calculating investments.

Calculating investments   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 583

Calculating depreciation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 590

Analyzing securities  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 593

Using the Euro Currency Tools add-in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 598
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TABLE 16-1 Investment function arguments

Argument Description

Future value The value of an investment at the end of the term (0 if 
omitted).

value1, value2, … value n Periodic payments (inflows) when individual amounts differ.
Number of periods Term of investment.
Payment Periodic payments when individual amounts are the same.
Type When payment is to be made (0 if omitted); 0 = at end of 

period; 1 = at beginning of period.
Period Number of an individual periodic payment.
Present value Value of investment today.
Rate Discount rate or interest rate.
Guess A starting interest rate for iterative calculations (10 percent 

if omitted).
Finance rate The rate at which you borrow money to purchase an 

investment.
Reinvestment rate The rate at which you reinvest cash received from an 

investment.

The PV function
Present value (PV) is one of the most common methods for measuring the attractiveness 
of a long-term investment. Present value is the current value of the investment. It’s deter-
mined by discounting the inflows (payments received) from the investment back to the 
present time. If the present value of the inflows is greater than the cost of the investment, 
the investment is a good one.

The PV function computes the present value of a series of equal periodic payments or of a 
lump-sum payment. (A series of equal payments is often called an ordinary annuity.) This 
function takes the arguments rate, number of periods, payment, future value, and type; for 
definitions of these arguments, see Table 16-1. To compute the present value of a series 
of payments, type a value for the payment argument; to compute the present value of a 
lump-sum payment, type a value for the future value argument. For an investment with 
both a series of payments and a lump-sum payment, use both arguments.

Here’s a real-world example of how this function works: Suppose you are presented with an 
investment opportunity that returns $1,000 each year over the next five years. To receive 
this annuity, you must invest $4,000. Are you willing to pay $4,000 today to earn $5,000 
over the next five years? To decide whether this investment is acceptable, you need to 
determine the present value of the stream of $1,000 payments you will receive.
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Assuming you could invest your money in a five-year CD money-market account at 2.1 
percent, we’ll use 2.1 percent as the discount rate of the investment. (Because this discount 
rate is a sort of hurdle over which an investment must leap before it becomes attractive to 
you, it’s often called the hurdle rate.) To determine the present value of this investment, use 
the formula =PV(2.1%, 5, 1000), which returns the value –4699.81, meaning you should be 
willing to spend $4699.81 now to receive $5,000 over the next five years. (Negative values 
indicate money going out; positive values indicate money coming in.) Because your invest-
ment is only $4,000, you can surmise that this is an excellent investment.

Suppose you’re offered $5,000 at the end of five years instead of $1,000 for each of the 
next five years. Is the investment still as attractive? To find out, use the formula =PV(2.1%, 
5,, 5000). (Include a comma as a placeholder for the unused payment argument.) This for-
mula returns the present value –4506.52, which means that at a hurdle rate of 2.1 percent, 
you should be willing to spend $4,506.52 to receive $5,000 in five years. Although the pro-
posal might not be as attractive under these terms, it’s still acceptable because your invest-
ment is only $4,000. However, it also makes a guaranteed 2.1 percent CD look a bit more 
attractive by comparison.

The NPV function
The NPV function calculates the net present value, which is another common method for 
determining the profitability of an investment. In general, any investment that yields a net 
present value greater than zero is considered profitable. This function takes the arguments 
rate, value1, value2, and so on; for definitions of these arguments, see Table 16-1. You can 
use as many as 254 separate inflow values as arguments, but you can include any number 
of values by using an array as an argument.

NPV differs from PV in two important respects. Whereas PV assumes constant inflow values, 
NPV allows variable payments. The other major difference is that PV allows payments and 
receipts to occur at either the beginning or the end of the period, whereas NPV assumes 
that all payments and receipts are evenly distributed and that they occur at the end of each 
period. If the cost of the investment must be paid up front, you should not include the cost 
as one of the function’s inflow arguments but should subtract it from the result of the func-
tion. On the other hand, if the cost must be paid at the end of the first period, you should 
include it as a negative first inflow argument. Let’s consider an example to help clarify this 
distinction.

Suppose you are contemplating an investment on which you expect to incur a loss of 
$85,000 at the end of the first year, followed by gains of $95,000; $140,000; and $185,000 
at the ends of the second, third, and fourth years. You will invest $250,000 up front, and the 
hurdle rate is 8 percent. To evaluate this investment, use the formula =NPV(8%, –85000, 
95000, 140000, 185000) –250000.




